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1. ЦЕЛЬ И ЗАДАЧИ ДИСЦИПЛИНЫ 

Цель: сформировать фундаментальное представление и геохимии магматических 

и метаморфических процессах. 

 Задачи: 

  - углубить и расширить представления о магматических и метаморфических 

процессах, их эволюции, химическом и минеральном составе магматических и 

метаморфических горных пород; 

  - познакомить с основными закономерностями поведения химических элементов 

при магматических и метаморфических процессах; 

  - дать представления о формах миграции и накопления химических элементов в 

метаморфических и магматических процессах. 

 

2. МЕСТО ДИСЦИПЛИНЫ В СТРУКТУРЕ ОПОП ВО 

Учебная дисциплина относится к части формируемой участниками 

образовательных отношений. Изучение данной дисциплины базируется на знаниях, 

умениях и навыках, сформированные следующими предшествующими дисциплинами: 

«Геохимия процессов рудообразования», «Современные проблемы геологии», 

«Геохимия элементов», «Минералогия и процессы минералообразования». 

Полученные в рамках изучения данной дисциплины знания, умения и опыт 

необходим для освоения таких дисциплин как: «Геохимические индикаторы 

геодинамических обстановок», «Петрология», «Интерпретация геохимических 

данных». 

 

3. ТРЕБОВАНИЯ К РЕЗУЛЬТАТАМ ОСВОЕНИЯ ДИСЦИПЛИНЫ 

Процесс изучения дисциплины направлен на формирование у студента 

следующих компетенций (элементов следующих компетенции) в соответствии с ФГОС 

ВО по направлению подготовки 05.04.01 Геология: 

 

Перечень планируемых результатов обучения по дисциплине, соотнесенных с 

индикаторами достижения компетенций 

Компетенция 

Индикаторы 

достижения 

компетенции 

Результаты обучения 

ПК-1 

Способен использовать 

фундаментальные 

теоретические знания 

при решении научно-

исследовательских задач 

в области геологии  

 

ИД-1ПК1 

Использует современные 

положения 

фундаментальных 

геологических 

дисциплин на разных 

этапах осуществления и 

сопровождения научно-

исследовательских работ 

Знать: Основные 

закономерности поведения 

химических элементов в 

магматических и 

метаморфических процессах 

Уметь: Анализировать 

геологическую информацию 

для выявления геохимических 

особенностей территории, 

связанных с 

метаморфическими 

процессами 

Владеть: Навыками 

организации геохимических 

научных и прикладных 

исследований 

ИД-2ПК1 

Воспринимает 

фундаментальные 

Знать: Условия миграции и 

накопления элементов в 

магматических и 



теоретические знания 

как способ получения 

фактической 

информации и 

инструмент для создания 

моделей и 

интерпретации 

результатов научных 

исследований 

метаморфических процессах 

Уметь: Интерпретировать 

полученную информацию, 

излагать в устной и 

письменной форме 

результаты своего 

исследования и 

аргументировано отстаивать 

свою точку зрения в 

дискуссии 

Владеть: Навыками 

выявления закономерностей 

поведения химических 

элементов и выяснении 

петрогенетических процессов 

ПК-4 

Способен изучать и 

использовать научно-

техническую 

информацию, применять 

отечественный и 

зарубежный опыт при 

выполнении задач 

научно-

исследовательской 

работе 

 

ИД-1ПК4 

Использует учебную, 

справочную, 

периодическую, 

фондовую литературу и 

информационные 

ресурсы геологического, 

геохимического и 

экологического профиля 

при выполнении научно-

исследовательских работ 

Знать: Основы миграции и 

накопления химических 

элементов в метаморфических 

и магматических процессах 

Уметь: Применять методы и 

компьютерные программы 

обработки геохимической 

информации 

Владеть: Методами 

системного анализа 

геохимических условий 

миграции и накопления 

химических элементов 

ИД-2ПК4 

Ориентируется в 

структуре современных 

информационных 

источников, ресурсов и 

литературе для поиска и 

подбора актуальной 

информации или 

углубления знаний в 

рамках решения  

конкретной 

профессиональной 

задачи  

Знать: основные методы 

получения геохимической 

информации 

Уметь: Анализировать 

результаты геохимических 

аномалий 

Владеть: навыками оценки 

перспективности аномалий 

ПК-5 

Способен составлять 

графические материалы, 

характеризующие объект 

исследования  

 

ИД-1ПК5 

Разбирается в видах, 

назначении, принципах 

построения диаграмм, 

схем, карт и других 

графических материалов, 

характеризующих 

аналитические данные, 

природные процессы, 

модели и объект 

исследований 

Знать: Основы методов 

представления геохимической 

информации 

Уметь: Применять методы и 

компьютерные программы 

обработки геохимической 

информации 

Владеть: Методами 

системного анализа 

геохимических условий 

миграции и накопления 



химических элементов 

ИД-2ПК5 

Использует необходимые 

технические средства и 

программные продукты 

для подготовки 

графических материалов 

Знать: основные методы 

представления и анализа 

геохимических данных 

Уметь: Анализировать 

геохимические данные с 

помощью инструментов MS 

Exel 

Владеть: навыками 

построения 

картографического материала 

 



4. СОДЕРЖАНИЕ И СТРУКТУРА ДИСЦИПЛИНЫ 

Объем дисциплины составляет 3 зачетных единиц, что составляет 108 академических часов,  в том числе  3 академических часов на 

зачет. Из них 36 часов – практическая подготовка. 

Форма промежуточной аттестации: зачет во 2 семестре 

4.1 Содержание дисциплины, структурированное по темам, c указанием видов учебных занятий и отведенного на них 

количества академических часов 

№ 

 
Раздел дисциплины/тема 

С
ем

ес
т
р

 

В
се

г
о

 ч
а

со
в
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н
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р
а
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ч
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к
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я
 

п
о

д
г
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т
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в
к

а
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б
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ч
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ю
щ

и
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ся
 

Виды учебной работы, 

включая самостоятельную работу обучающихся, 

практическую подготовку и трудоемкость 

(в часах) 

К
о

н
т
р

о
л

ь
 с

а
м

о
ст

о
я

т
ел

ь
н

о
й

 р
а

б
о

т
ы

  
 

(в
 ч

а
са

х
) 

Формы текущего 

контроля 

успеваемости / 

форма 

промежуточной 

аттестации 

Контактная работа преподавателя с 

обучающимися 

С
а

м
о

ст
о

я
т
ел

ь
н

а
я

 р
а

б
о

т
а

 

Лекции 

Семинарские/ 

практические/ 

лабораторные 

занятия 

Консультации 

1 
Метаморфизм. Основные понятия и типы 

метаморфизма 
2 8,2  4   4 

0,2 
Устный опрос 

2 
Метаморфические фациальные серии и 

петрогенетические сетки, изограды 
2 28,2 18 6 18  4 

0,2 Устный опрос 

3 
Геохимия зональных метаморфических 

комплексов 
2 10,2  6   4 

0,2 Устный опрос 

4 
Магматизм. Общие сведения о магматизме и 

классификация магматических пород 
2 30,4 18 6 18  6 

0,4 Устный опрос 

5 

Факторы, определяющие механизмы 

формирования и эволюции магм полного спектра 

по кремнекислотности 

2 12,5  6   6 

0,5 Устный опрос 



6 

Магматические серии различных 

геодинамических обстановок. Внутриплитовый 

магматизм. Субдукционный островодужный 

магматизм 

2 15,5  8  1 6 

0,5 Устный опрос 

 Всего  108 36 36 36 1 30 2 зачет – 3,0 часа 

 

4.2. План и перечень тем самостоятельной работы обучающихся по дисциплине 

№ Название раздела, темы 
Вид самостоятельной 

работы 

Оценочное 

средство 

Формируемый 

индикатор 

достижения 

компетенции 

Учебно-методическое 

обеспечение самостоятельной 

работы 

Трудоемкость, 

часов 

1 
Метаморфизм. Основные 

понятия и типы метаморфизма 

Выполнение 

домашнего задания 
собеседование 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1 

См.п. 5 - учебно-

методическое и информац. 

обеспечение дисциплины  

4 

2 

Метаморфические фациальные 

серии и петрогенетические 

сетки, изограды 

Выполнение 

домашнего задания собеседование 
ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1 

См.п. 5 - учебно-

методическое и информац. 

обеспечение дисциплины  

4 

3 
Геохимия зональных 

метаморфических комплексов 

Выполнение 

домашнего задания 
собеседование 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1 

См.п. 5 - учебно-

методическое и 

информацю.обеспечение 

дисциплины  

4 

4 

Магматизм. Общие сведения о 

магматизме и классификация 

магматических пород 

Выполнение 

домашнего задания собеседование 
ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1 

См.п. 5 - учебно-

методическое и информац. 

обеспечение дисциплины  

6 

5 

Факторы, определяющие 

механизмы формирования и 

эволюции магм полного спектра 

по кремнекислотности 

Выполнение 

домашнего задания  

собеседование 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-1ПК5 

См.п. 5 - учебно-

методическое и информац. 

обеспечение дисциплины  
6 



6 

Магматические серии 

различных геодинамических 

обстановок. Внутриплитовый 

магматизм. Субдукционный 

островодужный магматизм 

Выполнение 

домашнего задания 

собеседование 
ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-2ПК5 

См.п. 5 - учебно-

методическое и информац. 

обеспечение дисциплины  6 

 



4.3. Содержание учебного материала 

1. Метаморфизм. Основные понятия и типы метаморфизма. Факторы метаморфизма. 

Геодинамические обстановки. Типы метаморфизма 

2. Метаморфические фациальные серии и петрогенетические сетки, изограды. 

Метаморфические фации. Петрогенетические сетки.  

3. Геохимия зональных метаморфических комплексов. Прогрессивный региональный 

метаморфизм. Патомский метаморфический комплекс повышенных давлений. 

Поведение элементов при метаморфизме. 

4. Магматизм. Общие сведения о магматизме и классификация магматических пород 

5. Факторы, определяющие механизмы формирования и эволюции магм полного 

спектра по кремнекислотности. 

6. Магматические серии различных геодинамических обстановок. Внутриплитовый 

магматизм. Субдукционный островодужный магматизм. 

 

Перечень семинарских, практических занятий и лабораторных работ 

№ 

п/н 

№ 

Раздела и темы 

Наименование 

семинаров, 

практических и 

лабораторных работ 

Трудоемкость 

(час.) 

 

Оценочные 

средства 

Формируемые 

компетенции 

(индикаторы) 

 

1 

Метаморфизм. 

Основные 

понятия и типы 

метаморфизма 

Обучение навыков 

построения 

интерполированных 

поверхностей в 

Surfer на основе 

геохимических 

данных и их 

оформление в 

QGIS. 

18 

Расчетно-

графическое 

задание 

ИД-1ПК4, ИД-

2ПК4, ИД-1ПК1, 

ИД-2ПК1, ИД-

1ПК5 

2 Магматизм. 

Общие 

сведения о 

магматизме и 

классификация 

магматических 

пород 

Обучение навыкам 

работы с 

геохимическими 

данными в целях их 

визуализации в 

виде карты 

18 

Расчетно-

графическое 

задание 

ИД-1ПК4, ИД-

2ПК4, ИД-1ПК1, 

ИД-2ПК1, ИД-

2ПК5 

 

 

4.4. Методические указания по организации самостоятельной работы 

студентов       

Практическая работа №1 

Цель: Обучение навыков построения интерполированных поверхностей в Surfer на 

основе геохимических данных и их оформление в QGIS. 

Ход выполнения работы (Методика выполнения задания): 

В практической работе рассматривается построение интерполированных 

поверхностей геохимических данных. Имеется таблица точек отбора геохимических проб 

с аналитическими исследованиями. Для этих данных на протяжении предыдущих 4 

практических занятий производилась подготовка, обработка и статистический анализ. Для 

построения картографических представлений какого-либо химического элемента из этой 

таблицы необходимо выполнить построение интерполированной поверхности, другими 



словами произвести процесс интерполяции. В настоящее время существует множество 

программ, способных выполнить данную операцию (QGIS, ArcMap, SagaGIS, Surfer и др.).  

В этой работе рассматривается процесс интерполяции в программе Surfer по 

причине того, что она является очень мощной и первоначально создавалась именно для 

таких целей. А само оформление полученной интерполированной поверхности, а в 

последствии и создание карты изолиний химических элементов будет производится в 

программе QGIS. Модуль интерполяции в QGIS на данный момент времени реализован в 

сильно укороченном виде и получить какой-либо качественный результат не 

представляется возможным. 

Чтобы произвести интерполяцию в Surfer необходимо выполнить следующие 

операции: 

1. Запустить программу Surfer 

2. Выбрать инструмент «GridData» и указать таблицу с массивом исходных 

геохимических данных. 

3. В открывшемся окне следует выбрать XYZ. В качестве X и Y выступают 

координаты точек пробоотбора, а Z – параметр, который планируется 

проинтерполировать.  

3.1. Далее следует выбрать метод интерполяции и его дополнительные настройки 

нажав кнопку «Advanced Options». 

3.2. В окне «Advanced Options» следует выбрать значения сглаживания данных 

(рис. 20.1), которое настраивает уровень сглаживания данных. Здесь нужно для 

пользователя понимать, что чем больше указано значение сглаживания, тем сильнее будет 

сглажено значение поля в контрольных точках, на основе которых выполняется 

интерполяция. И в этом же окне настроек необходимо указать радиус поиска. Выбор 

радиуса зависит от размера исходной сети опробования и, обычно, указывается в 2 – 2,5 

раза больше. Например, при сети опробования 200х40 м. шаг следует указывать в 400х80 

м. Но в каждом конкретном случае шаг подбирается индивидуально. 

3.3. После настройки дополнительных опций метода интерполяции следует 

выбрать значение шага (spacing) регулярной сетки. Шаг регулярной сети регулирует 

размер одного пикселя на результирующих интерполированных поверхностях - гридах 

(*.grd) и указывается в метрах. Выбор шага зависит от будущего масштаба построенных 

картографических представлений и ограничений объема, которое займет грид на жестком 

диске. 

3.4. В полях «Grid Z limits» можно посмотреть минимальные и максимальные 

значения концентраций интерполируемого элемента, а также можно указать лимиты 

самостоятельно, ограничив значения выше или ниже определенного уровня. 

3.5. Указать место сохранения результата интерполяции и его название. 

После всех настроек интерполяции при нажатии клавиши «OK» программа начнет 

процесс интерполяции, после которого сообщит пользователю об успешном выполнении 

и предложит сохранить дополнительный файл привязки, в котором указывается в какой 

системе координат создан файл. Этот файл не обязателен и пользователь вправе выбрать 

самостоятельно, нужен ли этот файл последующей работе. По завершению расчетов в 

директории на жестком диске, создастся файл *.grd, который нужно загрузить в какую-

либо ГИС для последующего оформления и построения карты.  

В этой работе рассматривается пример оформления интерполированной 

поверхности в QGIS. 

Загрузка grd в QGIS производится путем использования инструмента «Открыть 

растр» или простым переносом мышью в рабочее поле QGIS. По итогу в рабочем поле и в 

панели слоев появится новый растровый слой. Как видно, загруженный растр черно-

белый и пользователю непонятно распределение элемента по площади. Чтобы карта стала 

наглядной и характеризовала распределение элемента необходимо оформить загруженный 

grd файл правильным образом. 



Для этого нужно зайти в свойства растрового слоя путем нажатия правой кнопки 

мыши  на слой в панели слоев и в выпадающем окне выбрать «Свойства» или двойным 

кликом мыши на слое. В открывшемся окне в левом меню переходим в пункт стиль, в 

котором будем настраивать оформление интерполированной поверхности. 

1. Первым этапом необходимо поменять пункт «Изображение» на одноканальное 

псевдоцветное. Таким образом мы переходим от черно-белого изображения к цветному.  

2. В графе «канал» указывается канал (если их больше одного (может быть 

несколько при работе с космоснимками)), в графах «мин.» и «макс» указываются 

минимальные и максимальные значения поля при необходимости (по умолчанию 

показываются мин. и макс. значения слоя). 

3. Далее указывается интерполяция цвета и цветовой ряд. Она может быть 

линейной (плавное изменение цвета в зависимости от значений, а может быть дискретной 

(в этом случае переходы от интервала к интервалу будут более резкими). Цветовой ряд 

настраивается в зависимости от требований к карте и может быть в выставлен любого 

цветового оттенка.  

4. Следующим этапом оформления необходимо установить диапазоны значений, к 

которым будет применяться выбранная цветовая схема. Выполнено это может быть одним 

из трех способов: непрерывный (значения раскрашиваются для всех значений непрерывно 

без разделения на отдельные интервалы); равные интервалы (значения раскрашиваются 

для всего диапазона значений, который разделяется на равные интервалы. Кол-во 

интервалов указывается зависимости от требований пользователя. Чем больше классов, 

тем плавнее переходы в целом по карте); квантили (значения раскрашиваются на основе 

гистограмм распределения элементов и учитываются статистические параметры, где в 

центральный диапазон будет соответствовать медиане, а далее классы будут меняться в 

зависимости от стандартных отклонений).  

Более наглядный тип классификации – квантили. Потому что он показывает 

статистический характер распределения интерполированного элемента, и пользователь 

может оценить на сколько выше или ниже от фоновых концентраций распределение 

элемента. 

По итогу настройки оформления и нажатия кнопки «ОК» в основном окне 

программы, загруженный растр поменяет оформление. Здесь следует просмотреть карту и 

убедиться в правильности настройки, и что полученный результат полностью 

удовлетворяет представлениям пользователя. 

Практическая работа №2 

Цель:. 

Ход выполнения работы (Методика выполнения задания): 

1. Формирование таблицы полевых наблюдений 

Результаты геохимических исследований задаются в электронной таблице. При 

этом можно использовать встроенную в пакет Surfer таблицу или воспользоваться 

электронной таблицей Excel из пакета Microsoft Office. Рассмотрим пример формирования 

электронной таблицы. В данном примере воспользуемся встроенной таблицей, но 

заметим, что в некоторых версиях Surfer возникают проблемы при использовании 

русского языка. Поэтому, если Вам необходимо использовать в таблице русские буквы, то 

лучше воспользоваться программой Microsoft Excel, в которой сохранить данные с 

расширением Excel 5.0/95. 

Для открытия окна таблицы в программе необходимо щелкнуть левой кнопкой 

мыши по иконке с изображением таблицы, находящейся в верхней части окна. 

Примем для примера, что карту мы строим по продуктивному пласту А1, вскрытым 

разведочными скважинами на абсолютных отметках1 от 1,3 до 1,5 км со знаком минус 

(значит, вниз от уровня моря). В табличном виде это можно представить следующим 

образом: 

 



Таблица 

Глубина вскрытия разведочными скважинами кровли продуктивного пласта А1 

№ 

скважины 

Абсолютная. отметка 

вскрытия кровли пласта А1, м 

Координата 

X, м 

Координата 

Y, м 

1 

 

–1490 

 

0 

 

0 

 

2 

 

–1445 

 

3000 

 

0 

 

3 

 

–1300 

 

1500 

 

1500 

 

 Под абсолютной отметкой понимается положение пласта от «уровня моря» – 

некой условной геодезической поверхности, от которой отсчитываются все глубины и 

высоты на Земле. 

В электронную таблицу эти данные занесем следующим образом. В первые два 

столбца удобнее занести координаты (именно там Surfer ищет их по умолчанию). В третий 

столбец занесем значения абсолютных отметок пласта (в ней по умолчанию программа 

ищет значение Z). Все заголовки таблицы сократим и запишем латинскими буквами. 

Пример заполнения встроенной электронной таблицы. 

Сохраним файл с табличными данными по скважинам в файле с именем 

АбсОтмКрПластА1. Расширение файла по умолчанию выбираем Excel SpreadSheet (*.xls). 

File>Save> АбсОтмКрПластА1.xls. 

Естественно, что название файла Вы можете задавать по своему усмотрению. 

Авторы рекомендуют создать для сохранения результатов, например, на диске С: 

отдельный каталог и внутри него создать следующие подкаталоги: DAT – для сохранения 

файлов с данными, SET –для сохранения файла настроек Surfer, GRID – для сохранения 

сеточных файлов, SRF – для сохранения Plot окон, BLN – для сохранения файлов границ, 

CLR – для сохранения заливок карт. Соответственно сохраняемый табличный файл 

следует записать в подкаталог DAT. 

2. Построение схемы расположения пунктов наблюдений 

Для визуализации в окне Plot1 точек расположения пунктов физических 

наблюдений, пикетов или скважин на карте необходимо выбрать соответствующее окно 

Plot: меню > Window > Plot1. Когда программа создает новое окно Plot, она присваивает 

этому окну следующий по порядку номер. Поэтому окон Plot может быть несколько. В 

нашем случае только одно окно Plot1, и последовательность действий будет следующая: 

Window > Plot1 > Map > PostMap > NewPostMap > C:\MySurfer\Dat\ 

АбсОтмКрПластА1.xls. 

В окне появятся скважины в виде черных кружков.  

В левом окне менеджера Объектов (далее Object Manager) должен появиться объект 

с именем Map который состоит из подобъекта Post (Точки) и четырех осей (Правой – Right 

Axis, Левой – Left Axis, Верхней – Top Axis и Нижней – Bottom Axis). 

Если вместо кружочков точки скважин будут отображаться кре-стиками, то они 

будут сливаться с осями карты. 

Настроить вид карты Post можно в диалоговом окне свойств объекта. Для этого 

необходимо дважды щелкнуть по подобъекту Post в Object Manager, либо по его 

представлению в окне Plot1. Откроется диалоговое окно свойств объекта Map: Post 

Properties. В первой закладке General (Общие) можно посмотреть и при необходимости 

изменить координаты X и Y символа, изменить символ (Default Symbol), его размеры 

(Symbol Size) и т. д.  

Вид каждой из осей можно настраивать отдельно, но в данном случае мы 

рекомендуем их отключить, убрав, «галочки» в Object Manager. 

Для того, чтобы подписать скважины, зайдем на закладку Labels ( 

В строке выбора Worksheet Column for Labels (Столбец для подписей) None 



изменим на Column D:N-Skv и в строке выбора Position Relative to Symbol (Позиция 

относительно символа) выберем Above (Сверху). 

Для того, чтобы изменения в окне вступили в силу необходимо щелкнуть мышкой 

по кнопке Apply (Применить) и для окончания работы с диалоговым окном по кнопке ОК. 

Чтобы изменить размер и вид шрифта в диалоговом окне, необходимо щелкнуть по 

кнопке Font и в строке Faсe выбрать соответствующий шрифт (например, ArialCYR), а 

размер шрифта изменить в Points. 

3. Обоснование параметров грид-сети 

В отличие от ручного при компьютерном построении карт требуется выбирать 

метод расчета ГРИДА и задавать определенный для каждого метода набор параметров, от 

выбора которых зависит форма результирующей карты. Искусство построения карт на 

компьютере напрямую зависит от умения правильного подбора параметров. С другой 

стороны, необходимо представлять себе, какие погрешности возникают при расчете 

ГРИДА и как их можно минимизировать.  

В общем случае процесс пересчета значений картируемого параметра из 

нерегулярных исходных точек к равномерным узлам сетки происходит следующим 

образом.  

Прежде всего, должна быть задана сетка, в узлах которой будут рассчитываться 

значения картируемого параметра.  

Размеры этой сетки в программе Surfer могут быть заданы пользователем или 

автоматически рассчитаны средствами системы. Геометрия сетки определяется шагом 

(расстоянием) между узлами по оси Х и шагом (расстоянием) между узлами по оси Y. Это 

расстояние должно соотносится с плотностью точек исходных данных: чем выше 

плотность данных, тем меньше должно быть расстояние между узлами сетки.  

Surfer по некоторому алгоритму с использованием исходных данных рассчитывает 

значение в узле сетки. Выбор конкретного алгоритма имеет значительное влияние на 

окончательный вид карты. 

4. Создание грид-сети  

Прежде, чем вывести карту в изолиниях на экран необходимо пересчитать 

нерегулярные данные в регулярную прямоугольную сетку, которая сохраняется в формате 

файла с расширением *.grd (ГРИД). Для этого укажем системе файл с исходными 

данными: Grid > Data>C:\MySurfer\Dat\ АбсОтмКрПластА1.xls и попадем в диалоговое 

окно расчета ГРИДА (Grid Data). 

Необходимо убедиться, что в качестве столбца с координатами Х выбран Column 

A: X_skv, соответственно координате Y соответствует 

столбец Column B: Y_skv и значению абсолютных отметок Z соответствует Column 

С: ao_krA1. 

Группа «Gridding Method» (Метод гриддинга) позволяет выбрать нужный 

пользователю метод сеточной интерполяции. Выбор метода зависит от поставленной 

задачи. Оптимальным методом интерполяции, подходящим для большинства задач, 

считается метод Крайгинга (Kriging). Метод назван в честь Д.Г. Криге, 

южноафриканского горного инженера. Этот метод является геостатистическим методом 

гриддинга (гриддинг – сеточная интерполяция). Он отличается быстродействием и 

корректным приближением интерполированных в узлы значений параметра к его 

исходным значениям. 

В качестве метода интерполяции выбираем Kriging и щелкаем по кнопке ОК. По 

умолчанию система высвечивает на экране окно с сооб-щением, что расчет завершен и 

указанный сеточный файл *.grd создан (has been created) .Кроме этого, в окне Grid Report 

выводится информация о построенной регулярной сетке. Отключить окно Grid Report 

(отчет о построении сеточного файла) можно, убрав «галочку» в соответствующем 

разделе. 

5. Обоснование формы представления геофизического материала 



6. Построение графического макета карты 

Для визуализации рассчитанного ГРИДА в виде карты на экране необходимо 

выбрать меню > Map > Contour Map > New ContourMap > C:\MySurfer\Dat\ 

АбсОтмКрПластА1.grd. В окне Plot1 появится карта в изолиниях, а в Object Manager 

появится новый объект Map c подобъектом Contours. 

Для объединения карты скважин с картой изолиний в один объект нажмем на 

клавиатуре функциональную клавишу F2 и последовательно выберем пункты меню: Map 

> Overlay Maps. 

На этом простом примере видно, что процедура создания на экране карты в 

изолиниях состоит из трех основных этапов:  

 создания таблицы исходных точек; 

пересчета значений из таблицы исходных точек в прямоугольную сетку;  

вывода и оформления карты в окне Plot1. 

В качестве самостоятельной работы Вы можете вывести на экран через знакомое 

меню Map рассчитанный ГРИД в виде трехмерного изображения – Surface, карты 

затененного рельефа – Shaded Relief Map и объемного представления карты в виде каркаса 

– Wireframe. 

Отметим некоторые особенности оформления карт. Во-первых, местоположение 

подписей точек (в нашем случае это номера скважин) можно менять относительно 

центров точек, но для всех точек одновременно и на одно и то же расстояние. Подпись 

может располагаться над точкой (Above), под точкой (Below), справа от точки (Right), 

слева от точки (Left), по центру (Center), также можно задавать положение подписи 

пользователем (User Defined) в координатах относительно центра точки. 

В окне свойства точек (Post Properties), открытом на закладке Labels (Метки, 

подписи), можно менять относительное положение Подписей (Меток) в списке выбора, 

озаглавленном Position Relative to Symbol (Позиция относительно символа). 

Подчеркивание первой буквы Р в слове Position означает, что к этому списку выбора 

можно обращаться нажатием клавиш Alt+P. Это стандартное соглашение системы 

Windows, позволяющее быстро нажатием пары клавиш выполнять определенное в меню 

действие. 

В случае задания положения подписи пользователем (User De-fined) необходимо 

задать относительное положение Метки от центра точки по координате Х (X Offset) и Y 

(Y Offset). При этом необходимо помнить, какие единицы измерения выбраны в меню 

Preferences– сантиметры или дюймы (Inches). 

Границы сетки (контурной карты) определяют максимальные и минимальные 

значения координат X и Y (по умолчанию в Surfer устанавливаются минимум и максимум 

X и Y из файла данных АбсОтмКр-ПластА1.xls). При этом скважины попадают на края 

карты для того, чтобы скважины находились внутри карты необходи-мо построить новый 

ГРИД с расширенной областью его построения. Сначала разъединяем карты. Выбираем в 

Object Manager подъобъект Contours и осуществляем последовательность действий: Map > 

Break Apart Overlay. 

Выполняем уже знакомые нам действия при расчете ГРИДА: Grid > 

Data>C:\MySurfer\Dat\ АбсОтмКрПластА1.xls и попадем в диалоговое окно Grid Data, где 

даем новое имя в поле Output Grid File (выходной сеточный файл) и в полях Grid Line 

Geometry (Геометрия линий ГРИДА) по обоим направлениям X и Y на несколько метров 

уменьшаем Minimum (минимальное значение координаты) и увеличиваем Maximum 

(максимальное значение координаты). 

Следует отметить, что эти отклонения от минимального и максимального значений 

координат не должны быть большими, иначе погрешность построения изолиний около 

границы карты будет весьма существенной. 

Группа Grid Line Geometry определяет не только границы сетки (Minimum, 

Maximum), но и ее плотность (шаг сетки – Spacing, число линий – # of Lines). 



При комбинировании нескольких карт следует помнить, что начальные и конечные 

координаты на всех картах должны быть идентичны. То же касается и шагов сетки. 

Плотность сетки определяется числом линий сетки по направлениям X, Y и зависит от 

плотности исходных данных. При расчете сетки для конкретной карты необходимо 

исходить из того, что шаг Spacing должен быть равен или меньше расстояния между 

исходными точками данных. На основании этого рассчитывается шаг сетки. По 

умолчанию в SURFER плотность сетки принята равной 100 × 100 сеточных линий. 

Выполнив те же действия, что и при построении объединенной карты, т. е. 

построив новую карту: Map >Contour Map > New ContourMap по новому ГРИДУ и 

объединив ее с картой скважин, которая уже есть, Вы получите карту, где скважины 

находятся внутри карты. 

При этом по умолчанию каждая пятая изолиния будет подписана. Подписать 

изолинии при необходимости или не подписывать их вообще Вы можете, выбрав в Object 

Manager подобъект Con-tours и двойным щелчком левой кнопки мыши открыв диалоговое 

окно его свойств MAP: Contours Properties. Заходим на закладку Levels. 

В колонке Lable (Метка) каждая помеченная на карте изолиния обозначена словом 

Yes. Нажмем кнопку Lable. В открывшемся окне Lables можно изменить частоту подписи 

изолиний, напри-мер, заменив в поле Skip цифру 4 на 2 и последовательно нажав кнопки 

OK>Applay, получим карту, где подписана каждая третья изолиния. Можно подписывать 

изолинии выборочно, выделив слово No и двойным щелчком мыши поменяв его на слово 

Yes. 

7. Оформление отчетной карты 

Форма отчета, требования к оформлению отчетного материала 

 Отчет о выполненной работе предоставляется в электронном виде.  

 Подготовленная документация должна соответствовать требованиям ГОСТ. 

 

5. УЧЕБНО-МЕТОДИЧЕСКОЕ И ИНФОРМАЦИОННОЕ ОБЕСПЕЧЕНИЕ 

ДИСЦИПЛИНЫ  

5.1 перечень основной и дополнительной литературы 

основная литература 

1. Балашов Ю.А. Геохимия редкоземельных элементов. - М.: Наука, 1976. – 

267с. 

2. Браунлоу А.Х. Геохимия. – М.: Недра, 1984. – 463с. 

3. Вернадский В.И. Труды по геохимии. – М.: Наука, 1994. – 496 с. 

4. Козлов В.Д. Введение в геохимию. – Иркутск: Иркут. гос. ун-т, 2007. – 2007 

с. 

5. Макрыгина В.А. Геохимия отдельных элементов. Академическое 

издательство «ГЕО», 2011. – 195с. 

6. Антипин В.С., Макрыгина В.А. Геохимия эндогенных процессов. Часть II. 

Геохимия процессов метаморфизма и метасоматоза. Издательство ИГУ, Иркутск, 2006 г., 

130 стр. 

дополнительная литература 

1. Алексеенко В.А. Ландшафтно-геохимические исследования и окружающая 

среда. Изд-во Рост. Ун-та, 1989. -122 с. 

2. Беус А.А. Геохимия литоферы. 2-е изд. М.: Недра, 1981. – 196 с. 

3. Виноградов А.П. Геохимия редких и рассеянных химических элементов в 

почвах. 2-е изд. М.: Изд-во АН СССР, 1957. – 237с. 

4. Гольдшмидт В.М. Геохимические принципы распределения редких 

элементов // Редкие элементы в изверженных горных породах и минералах / Ред.В.В. 

Щербина. М.: Изд-во иностранной литературы, 1952. С. 9-16. 

5.2 периодические издания 

Геохимия, Петрология 



Geochimica et Cosmochimica Acta, Applied Geochemistry 

 

5.3. базы данных, информационно-справочные и поисковые системы 
http://www.nlr.ru (Российская национальная библиотека); 

http://www.viniti.ru (Реферативный журнал); 

http://www.library.ru (Виртуальная справочная служба); 

http://dic.academic.ru (Словари и энциклопедии); 

http://geo.web.ru (Информационные Интернет-ресурсы Геологического факультета 

МГУ); 

http://elibrary.ru (Научная электронная библиотека); 

http://www.sibran.ru (Издательство Сибирского отделения Российской Академии 

Наук); 

http://www.ribk.net (Российский информационно-библиотечный консорциум); 

http://vsegei.ru (Всероссийский научно-исследовательский геологический институт 

им. А.П. Карпинского). 

http://library.isu.ru/ru/resources/electronical.html (электронная библиотека - раздел 

информационного ресурса Научной библиотеки Иркутского государственного 

университета)  

 

6. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ ДИСЦИПЛИНЫ  

6.1. Учебно-лабораторное оборудование: 

При проведения лекционных и самостоятельных занятий по основным разделам 

дисциплины используются компьютеры, ноутбук, мультимедийный проектор, 

иллюстративный материал в форме компьютерных презентаций. При выполнении 

практических работ студенты используют аналитические базы данных (результаты 

спектрального количественного, микрозондового, химического количественного, 

нейтронно-активационного и др. анализов) и коллекции горных пород и минералов, 

находящихся в собственности ИГХ СО РАН.  

 

6.2. Программное обеспечение 

Базовое программное обеспечение МS Office  

 

6.3. Технические и электронные средства обучения: 
1. Мультимедийный компьютер (технические требования: графическая операционная 

система, аудио- и видео входы/выходы, возможности выхода в Интернет; оснащение 

акустическими колонками, микрофоном и наушниками; с пакетом прикладных программ). 

2. Мультимедиапроектор. 

 

7. ОБРАЗОВАТЕЛЬНЫЕ ТЕХНОЛОГИИ 

При реализации данной программы применяются следующие образовательные 

технологии: лекционно-семинарское обучение, практические работы, а также 

использование вычислительной техники и телекоммуникационных средств для 

реализации информационных процессов с целью оперативной и эффективной работы с 

информацией). 

 

8.ОЦЕНОЧНЫЕ МАТЕРИАЛЫ ДЛЯ ТЕКУЩЕГО КОНТРОЛЯ И 

ПРОМЕЖУТОЧНОЙ АТТЕСТАЦИИ 
Зачет по дисциплине выставляется за  выполнение всех практических заданий, 

контрольных работ и активное участие в опросах. 

http://www.nlr.ru/
http://www.viniti.ru/
http://www.library.ru/
http://dic.academic.ru/
http://geo.web.ru/
http://elibrary.ru/
http://www.sibran.ru/
http://www.ribk.net/
http://vsegei.ru/
http://library.isu.ru/ru/resources/electronical.html


 

8.1. Оценочные материалы для текущего контроля: 

Материалы для проведения текущего контроля знаний студентов: 

№ 

п/н 
Вид контроля Контролируемые темы (разделы) 

Индикаторы 

достижения 

компетенций 

(компоненты), 

которые 

контролируются 

1 Устный опрос 
Метаморфизм. Основные понятия и типы 

метаморфизма 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-1ПК5 

2 

Устный опрос 
Метаморфические фациальные серии и 

петрогенетические сетки, изограды 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-2ПК5 

3 

Контрольная 

работа № 1 Геохимия зональных метаморфических 

комплексов 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-1ПК5 

4 Устный опрос 

Магматизм. Общие сведения о 

магматизме и классификация 

магматических пород 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-2ПК5 

5 

Устный опрос Факторы, определяющие механизмы 

формирования и эволюции магм полного 

спектра по кремнекислотности 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-1ПК5 

6 

Контрольная 

работа № 2 
Магматические серии различных 

геодинамических обстановок. 

Внутриплитовый магматизм. 

Субдукционный островодужный 

магматизм 

ИД-1ПК4, ИД-2ПК4, 

ИД-1ПК1, ИД-2ПК1, 

ИД-2ПК5 

 

8.2 Оценочные материалы для промежуточной аттестации 

Примерный перечень вопросов для подготовки к зачёту. 

1. Геохимия магматического процесса связана с: температурой; давлением; 

объемом; плотностью; концентрацией. 

2. Очаги гранитоидного магматизма залегают на глубине:10-25 км; 25-50 ; >50 км. 

3. Очаги базальтового магматизма залегают на глубине: 10-25 км; 25-50 ; >50 км. 

4. Летучие компоненты магмы: понижают кислотность и подвижность расплава; 

повышают кислотность и подвижность расплава; понижают кислотность и повышают 

подвижность расплава. 

5. Метаморфизм протекает при следующих условиях: в коре выветривания; в 

литосфере; при температуре – 40 0С; 2000С; 6000С; при давлении – 1 МПа; 5 МПа; 10 

МПа; с участием химически активных веществ; без участия химически активных веществ; 

со структурным изменением горных пород; без структурных изменений горных пород. 

6. Космогенный (ударный) метаморфизм формирует минералы и породы: эклогиты; 

импактиты; кварц; алмаз; стишовит; рутил; рингвудит. 

7. Региональный метаморфизм формирует минералы и породы: кварц; мрамор; 

кварцит; сиенит; диорит; сланцы; каменный уголь; гнейсы; диабазы. 

8. Контактный метаморфизм формирует минералы и породы: анортозиты; 

роговики; пироксены; мервинит. 

9. Дислокационный метаморфизм формирует минералы и породы: милониты; 

катаклазиты; сиениты. 

10. Метаморфические породы по химическому составу: соответствуют 



химическому составу исходной горной породы; не соответствуют химическому составу 

исходной горной породы; частично изменяют химический состав 

11. Региональные метаморфические процессы приводят к дифференциации 

химического состава литосферы: нижние горизонты обогащаются Si, K. H, O, Na; нижние 

горизонты обедняются Si, K. H, O, Na; нижние горизонты обогащаются Mg, Fe. 

 
Критерии оценивания контрольных работ:  
Оценка «отлично» выставляется, если студент выполнил работу без ошибок и недочетов, 

допустил не более одного недочета.  

Оценка «хорошо», если студент выполнил работу полностью, но допустил в ней не более 

одной негрубой ошибки и одного недочета, или не более двух недочетов.  

Оценка «удовлетворительно», если студент правильно выполнил не менее половины 

работы или допустил не более двух грубых ошибок, или не более одной грубой и одной 

негрубой ошибки и одного недочета, или не более двух-трех негрубых ошибок, или одной 

негрубой ошибки и трех недочетов, или при отсутствии ошибок, но при наличии четырех-

пяти недочетов, плохо знает текст произведения, допускает искажение фактов.  

Оценка «неудовлетворительно», если студент допустил число ошибок и недочетов, 

превосходящее норму, при которой может быть выставлена оценка «3», или если 

правильно выполнил менее половины работы. 

 

 

 

Автор-составитель рабочей программы:   

 

Будяк А.Е., к.г.-м.н.                                                            ______________ 

(ФИО, ученая степень, ученое звание)    

Тарасова Ю.И к.г.-м.н.                                                                    ______________ 

(ФИО, ученая степень, ученое звание)          

Настоящая программа, не может быть воспроизведена ни в какой форме без 

предварительного письменного разрешения отдела аспирантуры и магистратуры ИГХ 

СО РАН. 

 

 

 


